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�
INTRODUCTION�tc "INTRODUCTION" \l 1�





Darwin Pond is an imaginary gene poolóa primordial puddle of genetic surprises.  More technically, Darwin Pond is an Artificial Life Simulation: a virtual world exhibiting the emergence of life-like behaviors.   But it's more than just a cool thing to watchóyou can participate in this artificial life simulation by building little scenarios and setting up experiments.   





Darwin Pond is inhabited by hundreds of wiggly things called "swimmers".  In a way, you could say these swimmers perform tiny histories of the evolution of swimming in the earth's waters by genetically "discovering" ways to get around.  They do this by evolving their anatomies and motions over many generations.  This is why this imaginary body of water is named "Darwin Pond", after Charles Darwin, the creator of the theory of evolution.  





In the Beginning...


It all starts with a writhing primordial soup of 400 random swimmers with essentially no swimming abilities.  The principle of survival of the fittest enables a few slightly skillful swimmers to eat and mate with other swimmers, thereby passing their "good" genes on to future generations.  Loser swimmers don't reproduce as much and so their genes don't get passed on to future generations.  Generation after generation, these better genes start to spread, while bad genes die off.  





The result: spontaneous emergence of better swimmers.  Soon, after primordial beginnings, the power of evolution becomes visible, as better swimmers start moving around the pond in search of food and mates.  


And it turns out that there is no one BEST swimming style.  Every time you run a new evolution, different swimming styles will come out of the Pondósome of them may be unexpected.  Some of them may make you giggle.  





Purpose in Life


Swimmers have exactly two goals in life (and not necessarily in this order):





1. Food


2. Sex





If only our lives could be that simple.  





Designer Evolution


While all of this evolution is going on, you can do a little playing God by reaching into this world and tinkering with the delicate Pond ecology, such as changing food growth rate and swimmer energy levels.  You can also do quite a few things to swimmers: create random ones, kill them, feed them, tweak their genes, clone them, transport them to different Ponds, or save their genes in a file and trade them with your friends.  





The Goals of Darwin Pond


Darwin Pond is an exploratory artificial life simulation.  It's not a game, in the sense that there is no particular way to win or lose, and there are no good guys or bad guys.  But you are free to make up your own goals as you explore.  For instance, you may try to...





ï	Breed the fastest swimmer possible


ï	Evolve a population of funny swimmers


ï	Just watch it go and learn about the principles of Darwinian Evolution


ï	Try to evolve a population of healthy three-legged swimmers 


ï	Create a nice screensaver 


ï	Get all the blue swimmers to take over the pond and wipe out all the red swimmers


ï	Find the smallest number of random swimmers and food it takes to spark evolution	


ï	Breed two different populations that can coexist in harmony





�
INSTALLATION�tc "INSTALLATION" \l 1�





1)	Insert the Darwin Pond CD into your CD drive





2)	The Darwin Pond Setup program should automatically come up.  If it doesn't, run "setup.exe" off the CD.  If there are no other Windows applications running, you should click Next.  





3)	The Setup program will tell you it is going to create a directory called "Darwin Pond".  It will show the destination directory in which it will be created.  Click Next.  Or, you can click Browse to change the destination directory.  The Setup program will now place Darwin Pond into that directory.  





4)	The Setup program will tell you the group name to which Darwin Pond will be added.  If this is OK, click Next.  You can change the group name by typing in the "Program Folders" line of the dialog.  





5) 	The Setup program will ask you if you want to read the README file.  Answer Yes or No.  





6)	You will be notified that Setup is complete.  Click OK.  








The Darwin Pond program can now be found in the destination directory specified in stage 3 (above).  You can also find it in the Short Menu under Programs in the Group you specified in stage 4 (above).  








A QUICK START�tc "A QUICK START" \l 1�





Assuming you have successfully installed Darwin Pond on your PC and have started it up, you may want to just take a little dip.  Here is a quick set of activities to help you get your feet wet:





1) Check Out a Few Sample Ponds


For starters, go to the Pond menu, and select Sample Ponds....  Load up one of the Sample Ponds.  These will give you an introduction to the kinds of things that can happen.    





2) Use the Microscope


Try out some of the microscope tools (the tools can be found in the control panel just above the test tubes: tools 4-7).  There are four tools to use: zoom in; zoom out; move view; and reset view.  These tools will let you zoom in for close inspection or zoom out for the Big Picture.  You can also use the scroll bars to move the microscope view.  





3) Do Some Things to a Swimmer


Load up a Sample Pond.  Now select one of the 7 buttons on the lower row of the tools area and go over to the pond and click on a swimmer.  See what happens.  Try another button.  And another!  These tools allow you to do a variety of things to a swimmer.  Explore!  (For specific information on what each tool does, check out the section on "The Tools").  





4) Dump a Swimmer into a Test Tube


If you see a swimmer that you like, choose the "select tool" (the first button in the tool set), and click on your favorite swimmer.  Then drag it over to the specimen area, where the test tubes are.  You'll notice that your cursor icon changes as you drag the swimmer over to the specimen area.   Drop it into an empty test tube.  It is now a SPECIMEN!  Watch it wiggle.





5) Save your Specimen


If you've placed your favorite swimmer into a test tube as a specimen, and you want to save its genes in a file, select the "save as" button (the arrow-shaped icon just below the test tube).  Darwin Pond will ask you to name the specimen.  After you name it, a file will be created which holds the specimen's genes.  This specimen can then be loaded up at any time (into an empty test tube) by selecting one of the "load specimen" buttons (one of the arrow-shaped buttons located above the test tube).  





6) Save a Pond


The whole state of affairs in the Pond can be saved as a file.  If you've got a pretty good thing going in the Pond and want to give it a name, and save it for later use, go to the Pond menu, and select Save as...  








SWIMMERS�tc "SWIMMERS" \l 1�





1) Why They Look Like They Do?�tc "1) Why They Look Like They Do?" \l 2�





Swimmers in Darwin Pond appear as colorful stick figures.  They live in a flat, shallow two-dimensional puddle of a world.  But don't let their simple bodies fool youóthey are capable of some quite complex and intriguing movements.  This is where the true richness of Darwin Pond lies - in lifelike motion.  





Swimmers display a few visual signs as to what they are doing and what may be on their wee minds.  The following list may help you understand exactly what you are seeing as you watch these curious critters live out their lives.  





Color 	


Swimmer coloration is genetically determined.  Body colors include red, orange, yellow, green, blue, and violet.  Swimmers can be multicolored, or "pure".  These colors are not merely decorative cosmetics serving as eye-candy for us humansóthese swimmers' coloration is a very important part of their intensely dramatic lives, and determine the course of evolution.  Coloration has everything to do with being attractive to potential mates (and thus, having progeny).  





Age	


Young swimmers are light in color (they're born white, and quickly fade into bright adult colors).  Old swimmers turn gray just before dying.  





Starving	


Hungry swimmers turn gray just before dying.





Proboscis	


Every swimmer has a long, black, head-like thing which serves as both an eating organ and as a reproductive organ.





Thickness	


The proboscis is thicker when the swimmer has recently feasted on a food bit.





Length	


The proboscis appears longer when the swimmer is interested in mating, and shorter when the swimmer is hungry.





The Love Blob	


Sometimes, at the end of the proboscis is a colored dot.  This indicates that the swimmer has fallen in love.  The color of the dot indicates the swimmer's favorite mate color.  








2) Mental States�tc "2) Mental States" \l 2�


Swimmers are not much on brains.  Their lives are pretty basic as far as what they perceive and what they want.  Remember: a swimmer has only two goals in life: food and sex.  Its whole life is spent pursuing food bits and potential mates.  At any given time, if you stop a swimmer and inquire what's on its mind (using the get swimmer info tool - see section on tools), you will notice that it will be in only one of six mental states: 





1) looking for a mate			4) looking for food


2) pursing a mate				5) pursuing food


3) mating				6) eating





Below is a chart which shows how a swimmer changes from one mental state to another:





�





Oh yea, and there's also "dead".  That happens either if a swimmer's energy drops to zero and starves, or if its age reaches "Maximum Lifespan".   





It's a Swimmer's Life


It's basically like this: every swimmer just wants to make babies.  But swimmers need to have enough energy for the mating game, so, as a prerequisite, they need to eat food bits regularly.  As long as a swimmer is not hungry, it will look around until it finds a swimmer whose body contains its favorite color.  If it does find one, it will fall in love.  Then it will pursue this loved oneórelentlessly, although there are three things that can make it change its mind: 1)  it got hungry and had to go off in search of food; 2) its loved one swam too far away and it went out of sight; or 3) its loved one got too old, weak, or just up and died.  In this case, it's back to the drawing boardógotta find another mate.  





This basically sums up the intellectual life of a swimmer.  The physical life is actually a bit more interesting, because swimmers can do quite a number of things with their bodies in order to get to their food or mates.  This is the part of Darwin Pond that evolves.  








3) Mating�tc "3) Mating" \l 2�


This is not exactly X-rated materialóeven though you may have started wondering by this time.  Since swimmers are conveniently rendered as little wiggling hieroglyphic biomorphs, there's not really much anatomy there that would give one a sense of voyeurism.  These swimmers are also genderless, or unisexóif you will.  There are no males or females.  Also, the actual act of mating consists of nothing more than the pursuing swimmer's proboscis coming in contact with its desired mate.  A little birth sound is heard and an egg or two appear at the juncture, which quickly grows into an adult swimmer.  The offspring inherit some combination of each parent's genes.  





Mutation


When a swimmer is born, there is a slight chance of mutation among a few of its genes.  This is usually hardly noticed, because the mutation is usually small.  But some mutations are big, such as having an extra limb or changing color.  





Sexual Attraction


Swimmers don't just mate with anybody.  They are selective.  What turns a swimmer on?  Simple: Swimmers' bodies consist of combinations of the following 6 colors: red, orange, yellow, green, blue, and violet.  If I'm a swimmer, I'm attracted to swimmers with colors similar to mine.  For instance, a swimmer with lots of blue in its body will look for a mate who also has lots of blue in its body.  The "bluer" the potential mate, the more attractive it is.  If that swimmer can't find any swimmers with blue, it will settle for a bit of green or violet in a pinch.  This is because green and violet are close to blue, as indicated by the color wheel shown below: 


�





As you might expect, solid-colored swimmers turn out to be the most attractive ones to other swimmers in the Pond, and so they get chosen for mating most often.  This is why populations usually become homogenous in color after long periods of time.  





More Body: More Color: More Sexy


Think about it: a yellow swimmer with two limbs living in a mostly-yellow population will be perceived as attractive by that population.  Now, what if that swimmer mates with an identical swimmer and has a baby with a chance mutation causing it to have three limbs?  That baby will grow up to be even more attractive than its parents, in the eyes of the population.  You could say it was a "lucky" mutation.  Why? This is because swimmers on the hunt for mates respond to the "amount" of its favorite color in potential mates.  Three legs of yellow are better than two.  The more body the potential mate has, the more colors it can flaunt to its admirers.  








4) Genetics�tc "4) Genetics" \l 2�


Each swimmer has 15 genes.  These genes affect the swimmer's anatomy, swimming motions, and coloration.  They are listed below.  





�
number of limbs


number of segments per limb


rate


amplitude


alternate limb flip 


straddle


turning gene #1


turning gene #2


turning gene #3


joint angle gene


motion gene #1


motion gene #2


motion gene #3


base color


color shift�






Some of these names are pretty straightforward, but others might appear cryptic to you.  That's because some of these genes are cryptic!  But, hey, compared to the real thing (like your DNA) these genes are a piece of cake.  As a matter of fact, if you are diligent enough, you can figure out what each gene does by exploring the swimmer's genes with the "engineer tool" (see section on Tools).  While some folks may prefer not to meddle with DNA, others might relish in cracking the puzzle of the genes.  





Gene Files


A swimmer's genes can be saved as a file on your PC by dragging the swimmer into an empty test tube and then selecting that test tube's "Save as..." button (located under the test tubeósee the section on test tubes for details).  A gene file consists of 15 real numbers.  Swimmer gene files have the extension ".dna", and are in ASCII format, and can be cut and pasted into all documents which display ASCII text characters.  





For those of you who are serious hackers, you may want to actually design a swimmer yourself by creating 15 real numbers in a word processor application, and then copying that text and pasting it into Darwin Pond.  But, chances are, the swimmer you design will be a bit awkward and confused, sort of like the Frankenstein monsteróif you know what I mean.  But try it anyway.  Could be fun!  








5) The Physics of Swimming�tc "5) The Physics of Swimming" \l 2�





Swimmers in Darwin Pond are not anything like cartoon characters.  There was no artist who labored over a series of images, drawing frame after frame of swimmer positions, to create the illusion of motion.  These swimmers animate themselves.  They are algorithmically generated.  And the ways they move and turn around are determined by physics equations.  A technique called "forward dynamics" is used to create the physical effects from stroking limbs through water to move or turn a swimmer's body.  





Stroking


If you swim yourself, you probably know that using large, broad strokes with your fingers together and hands flat can help you make more effective strokes in the water.  The same principle applies to swimmers' bodies.  The larger the area a swimmer can cover in a stroke, the more that swimmer will be able to push its body along, as indicated by the illustration below.  





� � � � � 





� � � � �





This swimmer's stroke has its maximum effect in frames 6-8 (lower left).  It also has the right kind of body for this kind of swimming, and no extra limbs which can get in the way of it's highly purposeful stroke.  If the swimmer had other limbs which were not contributing to the stroke, they could cause drag, counteracting the good strokes by impeding the swimmer's momentum.  


�
Undulating


Swimmers also can use undulating motions to propel their bodies.  These behaviors are usually found in the one-legged swimmers, and sometimes in two-leggers, like the one shown below.      





� � � � �





� � � � �








FOOD�tc "FOOD" \l 1�





Food bits can easily be detected in the Pond - they are those small green dots scattered randomly about.  Food is capable of reproducing as well as swimmers, but in a much simpler way.  Food bits periodically send off seeds which land somewhere in the pond and appear as new green dots.  A cluster of food bits, if left on its own long enough, will eventually spread outward and fill a large area of the pond.  





The Source of Energy


Food bits are the source of all energy in the Pond, and swimmers get all their energy from them.  Since swimmers have so much important work to doólooking for mates, pursuing them, foraging, competing for food bits, or just flailing about aimlesslyóthey never sleep or take summer vacations.  As a result, they are constantly burning off energy, and so they find themselves getting hungry frequently.  





...with the exception of those loser swimmers who just lie there, barely moving.  They don't burn off energyóyou could say they're energy efficient.  They just happen to not do anything all their lives.  





The following illustration shows how a swimmer's energy can be increased by eating a food bit, and how its energy is drained from the act of swimming and giving birth.  


�





Adding and Erasing Food


You can have a hand in affecting the abundance or scarcity of food by adding or erasing food bits.  Two buttons in the tools area with green icons (numbers 2 and 3) allow you to do these things.  There is a maximum food population (1000).  Once you've added this many food bits, no more can be added until some swimmers eat and bring the population down or you erase some food.  





THE POND�tc "THE POND" \l 1�





Darwin Pond is not like most ponds.  For one thing, it's square.  But don't let that distract youóthe swimmers are really where it's at.  The Pond also has a very basic ecologyóit consists merely of food bits and swimmers.  Food bits slowly reproduce and spread, while swimmers eat the food, evolve, and make babies for a living.  





1) The Garden of Eden�tc "1) The Garden of Eden" \l 1�





By going to the Pond menu and choosing "Garden of Eden", you can start with a primordial pond of 400 random swimmers and 1000 food bits scattered around near the swimmers.  There are 6 versions of the Garden of Eden, each with different arrangements of swimmers and food.    





Mass Extinction


Once in a blue moon, an evolving population will die off, simply on its own, with no warning, or obvious reason.  But there is in fact a reason.  It has to do with luck, chance, and the chaotic dynamics of genetic evolution.  Read up on your Stephen Jay Gould for some in-depth explanations of why species sometimes go extinct for un-obvious reasons.  But don't worry: swimmer populations rarely die out completelyóand if things do start to look grim, you can always add some food or some fresh random swimmers to the primordial stew, to help get things rolling again.  





2) Sample Ponds�tc "2) Sample Ponds" \l 2�


Darwin Pond comes with six pre-evolved Pond scenarios, each which demonstrate a particular aspect of swimmer behavior.  These are useful as introductions to Darwin Pond.  





3) The Empty Pond�tc "3) The Empty Pond" \l 2�


Also under the Pond menu is a menu called Empty Pond.  This gives you a blank slate: it clears the pond of all swimmers and food and lets you start from scratch.  Think of the empty pond as a painter's canvasóyou can add food bits, create new random swimmers, or load up evolved swimmers from previous populations.  





4) Pond Files�tc "4) Pond Files" \l 2�


You can save the state of the Pond at any time by going to the Pond menu and choosing Save, or Save as....  A standard Windows 95 dialog box appears asking for the name of the pond file you want to save.  Give it a name and select OK.  You can also load up a previously saved file by going to the Pond menu and selecting Open.  





5) The Passage of Time�tc "5) The Passage of Time" \l 2�


Time in Darwin Pond is measured in individual clock "ticks".  A tick is equivalent to a frame of animation.  In other words, every time the pond image is visually updated, time advances by one tick.  This can happen many times a second, like 10, or more.  





The animation rate of Darwin Pond on your PC may be different than it is on other PC's.  Faster Pentiums will run Darwin Pond faster than slower ones.  Also, you may notice that time runs slower when the swimmer population is at its largest.  This is because there are more calculations the computer must do in order to simulate and display the swimmers.  





Darwin Pond is not synchronized with real time, like the clock on your wall.  Since Darwin Pond uses "simulation time", as opposed to "real time", there is no such thing as a "second", or a "minute" or a "year".  So, swimmer ages are measured in time ticks.  The life span of a swimmer can range anywhere from 0 up to 40,000 time ticks.  








6) The Color of the Pond�tc "6) The Color of the Pond" \l 2�


There are four colors you can choose from as a background for swimmers and food.  These colors can be changed by going to the Options menu, and choosing Preferences.  Your four choices are Greenish, Bluish, Brownish, and Grayish.  





�
THE MICROSCOPE�tc "THE MICROSCOPE" \l 1�





In addition to conveniently being in the shape of a square, Darwin Pond is also different from other ponds in that it comes equipped with its own microscope.  And the Pond has also been miraculously squeezed into the size of a microscope slide! (don't ask for details).  





The microscope allows you to zoom in or out for different magnifications of the pond.  It also allows you to move the view left, right, up or down.  Standard Windows 95 scroll bars can be used as well as the microscope tools.  At any given time, you are looking at some subset of the pond with the microscope, as shown in the illustration below.  At no time can you see any of the area "outside" of the pond.  





�








The Microscope Tools�tc "The Microscope Tools" \l 2�


There are four ways to operate the microscope: 





1) Zooming in


When you zoom in, you close in on local areas of the pond and can see swimmers up close.  To zoom in, use the button with the "+" sign magnifying glass icon.  





2) Zooming Out


When you zoom out, you essentially bring more of the pond area into view.  The swimmers appear smaller because they are "farther away".  To zoom out, use the button with the "-" sign magnifying glass icon.  





3) Moving the View


When you move the view, you slide the microscope along to "pan" across the surface of the pond.  When the edge of the microscope hits the edge of the pond, it stops.  To move the view, use the button which has the icon with the hand.  You can also use the scroll bars at the right and bottom of your screen.  





4) Resetting the View


When you reset the view, you essentially do a "zoom out" on the microscope view instantaneously.  So, in the illustration above, the smaller square basically expands to the same size as the pond itself.  When you are zoomed out all the way, you cannot use the Move View tool because there is no space to move the view anymore.  To reset the view, use the button with the icon with the 4 outward radiating arrows.  





Keyboard Shortcuts�tc "Keyboard Shortcuts" \l 2�


Since you'll probably find yourself using the microscope a lot, you can use the following keys as quick substitutes to the tools:  





+		zoom in	(you can also use the i key )


- 		zoom out (you can also use the o key )


arrows	move the view up, down, left, or right


r		reset the view





View Settings �tc "View Settings " \l 2�





By selecting the View menu, you can control a few aspects of the microscope.  These are listed below:  





Full Screen �tc "Full Screen " \l 2�


When you select Full Screen, you toggle on or off the full screen mode.  In Full Screen, the entire specimen area, tools, and graph disappear, and the Pond takes over the whole screen (except for the scroll bars and the standard Windows bars at top).  In Full Screen mode, you give up controls and information, but you gain a bigger picture of the Pond.  Full screen mode can also be toggled on and off by pressing the F key.  





Autotracking �tc "Autotracking " \l 2�


Often you will find yourself zoomed in with the microscope and moving around to catch up with interesting activity as swimmers move around in the pond.  There is a special feature which takes over the microscope controls for you and does this for youóthe autotracker.  





The autotracker can be turned on by going to the View menu and choosing Autotracking.  You will notice that the magnification will move to a fixed distance, and the view will start moving around in an attempt to center itself on a cluster of swimmers.  While autotracking is on, you can still use the microscope controls to shift the view to an area that you are interested in which the autotracker is ignoring.  





The magnification of the autotracker can be set to something else by going to the Options menu and selecting Preferences, and then selecting Autotracking Magnification.  





Track Selected Swimmer �tc "Track Selected Swimmer " \l 2�


When you go to the View menu and select Track Selected Swimmer (if there is currently a swimmer selected), the microscope centers itself on that swimmer and tracks it wherever it goes.


 


Locate Selected Swimmer �tc "Locate Selected Swimmer " \l 2�


When you go to the View menu and select Locate Selected Swimmer (if there is currently a swimmer selected), the microscope centers itself on that swimmer so that the swimmer appears in the middle of the microscope view.  








THE MENUS�tc "THE MENUS" \l 1�





Below the title screen at the top of the window is the menu bar.  There are 6 menu options in Darwin Pond.  They are listed below. 





Pond	Lets you load up Sample Ponds or "Gardens" of Eden, save ponds, or load your own custom ponds.





Swimmer	Cut


	If there is a swimmer selected, choosing this menu option will delete the swimmer and place a copy of it in memory (the clipboard).  





Copy


If there is a swimmer selected, choosing this menu option will make a copy of the swimmer and place it in the clipboard.  





Paste


If there is a swimmer which you have "cut" or "copied" into the clip board, choosing Paste causes that swimmer to be pasted into the pond.  If there is a swimmer currently selected, the newly pasted swimmer replaces that swimmer.  If there is no swimmer selected, the newly pasted swimmer appears in the middle of the microscope view.    





View	Lets you control a few microscope settings: Full Screen, Autotracking, and Locate Selected Swimmer.





Tools	Replicates all the tools functionality in the tool set.  





Options	Has a variety of menus such as:





	Tweak Ecology


	Play Movie


	Sound Effects


	Music


	Preferences


	Population Graph


	Color Population Graph


	Freeze Simulation





Help	Brings up a scrolling dialog box with information about Darwin Pond.











Context Sensitive Menus


Also, there are right mouse button click (context sensitive) menus.  These are described below:





Swimmer	If you click with your right mouse button in the pond, you can get one of two context sensitive menus:  1) swimmer menu, or 2) general functions menu.  The swimmer menu has the following items:





Cut


Copy


Paste


Save 


Load


Kill Swimmer


Clone Swimmer


Zap Swimmer


Engineer Swimmer


Get Swimmer Info.





General	If you right mouse click into the pond area (not on a swimmer), the following menu appears: 





Tweak Ecology


Play Movie


Sound Effects


Music


Preferences 





These items correspond to the same-named functions as they appear in the Options menu in the menu bar.





  


Graph	This menu appears when you right-mouse click into the graph area.  It asks you which of the two graphs you want to display.  





Test Tubes





	By right-mouse clicking into the specimen area, you get a menu with the options Load, or Save.  








THE TOOLS�tc "THE TOOLS" \l 1�





14 buttons can be found just above the test tubes.  These are the tools.  To use a tool, place the mouse cursor on the tool and click.  Then when you move your cursor over to the pond, your cursor will look different.  This means that you are in a specific tool mode, indicated by your cursor icon.  You can now do a variety of things by clicking into the pond or on a swimmer.  The following list describes what each tool does:





1	Select			


	Selects a swimmer.  A gray circle appears around the swimmer and stays there until you select another swimmer.  If you click in the pondónot on a swimmeróno swimmer is selected.  The currently selected swimmer is the one which will be acted upon if you select one of the swimmer actions from a menu (see section on menus).   





2	Add Food	


	Creates a new food bit where you have clicked.  You cannot add more food if there are 1000 food bits in the pond.   





3	Erase Food


	If you click and drag this tool across the pond, any food you pass over will be killed.  





4	Zoom in	


	Zooms the microscope view in.  The magnification increases and swimmers appear larger.  You can also use the "+" or "i" keys for the same effect.  





5	Zoom out 


	Zooms the microscope view out.  The magnification decreases, swimmers appear smaller, and more of the pond comes into view.  You can also use the "-" or "o" keys for the same effect.  





6	Move View


	Moves the microscope view around.  You can also use the arrow keys or the scroll bars for the same effect.  





7	Reset View	 


	Sets the microscope magnification all the way outóthe view zooms out to show the whole pond.  (NOTE that this tool does its thing AS SOON AS you select the tool).  You can also use the "r" key for this.  





8	Add Random Swimmer


	Creates a new random swimmer.  Wherever you click your mouse cursor in the pond, a new swimmer appears whose genes are random.  Each swimmer will look different.  The maximum number of swimmers that can occupy the Pond is 450.  If the pond reaches its maximum of 450 swimmers, you will not be able to add any more.  





9	Kill Swimmer	 


	Kills the swimmer you click on.





10	Erase Swimmers


	All swimmers are killed as you click and drag the eraser over them.





11	Engineer Swimmer


	Opens up a dialog box with sliders that let you change individual swimmer genes.  The swimmer appears enlarged in the pond area against a grid so you can see the results of your genetic engineering immediately.  If you click and drag inside the swimmer window you can change the swimmer's focusówhich helps you see the results of some of your gene changes.  








12	Clone Swimmer


	When you click on a swimmer, an identical twin is created next to it.





13	Zap Swimmer


	When you use this tool and click on a swimmer, it mutates some of its genes.  Since this is a random mutator, the results are unpredictable.  Sometimes, the zapped swimmer will just get a little tweak in one of it's limbs.  Other times, it will zap it into an entirely new form, and change its characteristic movements.  





14	Get Swimmer Info


	You can click on a swimmer for a dialog box which gives some basic facts on that swimmer.  It tells you the swimmer's: 





	ï mental state


	ï age


	ï energy level


	ï number of limbs


	ï number of segments per limb


	ï preferred mate color


	





Each of these tools can also be accessed through the Tools menu.  By selecting one of the tools in the menu, you are put into that tool mode, as if you had selected that tool.  This is useful for when you are in full screen mode and cannot access the tools directly.    


 





TEST TUBES�tc "TEST TUBES" \l 1�





At the lower left of the window is the specimen area.  The specimen area includes 4 test tubes for you to keep specimens of your favorite swimmers, and some buttons for saving and loading specimens.  To store a specimen, click on a swimmer from within the pond and then drag it into an empty test tube as shown below.  As you move the swimmer out of the pond, you'll notice your cursor icon changesóthis means you are transporting a swimmer into the specimen area.  


�


This swimmer will then be in a state of suspended un-aging life, as long as it stays in the test tube.  If you load up a new pond, this swimmer will remain in the test tube.  You could then drag the swimmer out of the test tube at any time and place it in the new pond, and see how it survives in a different ecology.  





Test Tube Activities�tc "Test Tube Activities" \l 2�


You can clone copies of the specimen by holding down the SHIFT key and clicking on the specimen and dragging it out.  The original stays in the test tube and a clone gets dragged out.  





You cannot dump a swimmer into a test tube which already has a swimmer in it.  Sorry, only enough Pond water for one occupant at a time!  





If you are transporting a swimmer from the pond to a test tube or a specimen from a test tube to the pond, and you accidentally drop it in transit, it will automatically snap back to where it was when you picked it up (unless you drop it into another (empty) test tube).  





Saving and Loading Specimens�tc "Saving and Loading Specimens" \l 2�


Below the test tubes are buttons for saving test tube specimens as a file.  To save a specimen, select the button just under the test tube which that specimen occupies.  A dialog box will appear asking you to name the specimen.  Give it a name and select OK.  You now have created a file which holds the genes of that specimen.  





That specimen's genes can be loaded up at any time by going to an empty test tube and selecting its associated "load specimen" button (just above the test tube).  A dialog box will appear asking you the name of the specimen you want to load.  Enter the name and that specimen will appear in the test tube.  





You can also move your cursor on top of the specimen's test tube and press the right mouse button to get a dialog box which will allow you to do perform either these same functions.  








THE GRAPH�tc "THE GRAPH" \l 1�





The graph at the upper left shows the changes in swimmer and food populations over time.  There are two kinds of graphs you can view: 1) the population/food graph, or 2) the color graph.  You can switch between these two graphs by going to the Options menu, and choosing either Population Graph or Color Graph.  You can also place your cursor over the graph area and click the right mouse button for localized menu, with the two options.  





Updating �tc "Updating " \l 2�


The data shown in the graph is updated every 100 time ticks.  When you bring up a Garden of Eden, a Sample Pond, or an Empty Pond, the graph starts blank.  As time marches on, the lines in the graph begin to grow, starting from the left and creeping along towards the right.  At 10,000 time ticks, the graph fills the whole graph window.  It then begins scaling itself in order to accommodate more incoming population data while still fitting within the graph window.  This continues until the number of time ticks exceeds 100,000, at which time, the whole graph starts to slowly scroll to the left, as new data comes in at the right.  This scrolling continues forever.  





The Swimmer/Food Population Graph�tc "The Swimmer/Food Population Graph" \l 2�


This graph shows the population of swimmers over time as a white line, and the population of food bits over time as a green line.  The population of food can range from 0 to 1000 (the top of the graph), and the population of swimmers can range from 0 to 400 (unless you manually add new swimmers, in which case, there can be a maximum of 450).  The number of swimmers and food is displayed at the top of the graph (updated every 100 ticks, remember).  





The Color Graph�tc "The Color Graph" \l 2�


This graph shows the populations of the six races of swimmers over time: Red, Orange, Yellow, Green, Blue, and Violet.  Food population is not shown in this graph.  This graph is useful to see the histories of different races of swimmers as they emerge, get snuffed out by other races, or take over the pond.  





Population Dynamics�tc "Population Dynamics" \l 2�


You'll notice early in the evolution of Garden of Eden populations that the food suddenly drops within the first 100 ticks.  This is because there is a lot of food in the Garden of Eden and swimmers born right next to food bits get to immediately eat them, bringing the food population down suddenly.  Lucky little critters.  





You might also notice, later on, that when the food population goes up, the swimmer population goes up too (because swimmers are eating more), which then causes food population to drop (because swimmers are eating more), which then causes the swimmer population to drop (less food), which then.....  And so on.  Food and swimmer populations will end up oscillating over time.  These oscillations will be different in nature if you alter some of the ecological settings (see next section).  








TWEAKING THE ECOLOGY�tc "TWEAKING THE ECOLOGY" \l 1�





You can fiddle with the delicate ecology of Darwin Pond using the Tweak Ecology feature.  The things you can change here affect the overall behavior of the swimmers and food as a whole system.  The Tweak Ecology Feature allows you to alter the following:





Food Growth Switch


This turns on or off the capacity for food to regenerate itself.  When this is "off", no new food will grow in the pond.  When it is "on", existing food bits (if there are any) will send off seeds which land somewhere in the pond and appear as new bits.  





Food Growth Rate 


This affects the rate at which new food bits are regenerated.  A lower setting causes food to regenerate slowly.  A higher setting causes food to regenerate quickly.  





Food Spread


This affects the distance that new food seeds are spread across the pond as they regenerate.  If this is set low, then new food bits will appear close to pre-existing food bits, creating tight clusters.  If it is set high, then new food bits will spread larger distances across the pond and eventually fill the whole pond.  





Energy Transferred From Mating


When two swimmers mate, they each give up a certain amount  of energy which is transferred to their offspring.  Under normal conditions, the offspring get just enough energy to get to food before starving, but are born hungry.  The parents usually are hungry after mating because of the energy they have given up for their offspring.  Changing this value can cause major differences in the way a population grows.  If it is set to the lowest setting, parents contribute nothing to their offspring and so their children die immediately.  If it is set to the highest setting, the parents take a big hit, and sometimes die as a result.  What's the ideal amount a parent should nurture its offspring?  It probably depends on many other factors.  





Energy From Food


This affects the amount of energy a swimmer gets when it eats a food bit.  If this is set at the lowest setting, the swimmer gets no energy.  If it is set high, the swimmer gets lots of energy and its proboscis thickens to show it.  





Hunger Threshold


This affects the amount of energy swimmers can stand to have before they get hungry and start looking for food.  If this is set at the lowest setting, swimmers will continue the mating game up to the moment they are starved.  If hunger threshold is set high, swimmers will find themselves hungry almost all the time, and will gorge most of their lives.  Disgusting.  





Maximum Life Span


This determines the maximum age swimmers can live to before they die of old age.  If this is set at the lowest setting, swimmers will all immediately die.  If it is set at the highest setting, swimmers have the potential to live for 40,000 ticks.  








THE TIME-LAPSE MOVIE�tc "THE TIME-LAPSE MOVIE" \l 1�





Darwin Pond has a unique feature which lets you see an instant replay of the events that have been going on in the Pond.  You see the evolution in the whole Pond unfolding rapidly before your eyes.  The Time-lapse Movie shows a fast-paced animation of swimmers and food moving around in the pond, starting from the moment you loaded up the pond to the latest time tick.  Swimmers are shown as colored dots and food is shown as smaller green dots.  





To run the time-lapse movie, go to the Options menu and select "Time-lapse Movie".  A dialog box will appear with the following controls: 


�





Press Play and the movie begins to play.  At any time you can Stop or Rewind the movie.  When you are done watching the movie, select Exit.





Recording the Time-lapse Movie


In order to create a time-lapse movie, Darwin Pond has to periodically save images of the pond to a temporary file, which grows larger and larger as the program runs.  This file is created as soon as you load up a new pond.  It disappears as soon as you exit Darwin Pond.  Its purpose is to store frames to be animated whenever you play the movie.  





Since this file takes up room on your hard drive, you can decide the maximum size this file can become before it stops growing, by going to the Options menu and selecting Preferences.  There you will find five settings for the Time-lapse movie: ï†Off    ï Short    ï Medium    ï Long    ï Unlimited  





If you choose Off, there will be no file and the Time-lapse movie feature will be disabled.  If you choose Short, Medium, or Large, a time-lapse movie file will be created and it's size (and hence, the duration of the movie) is constrained (the approximate file size is explained in the dialog box).  If you choose Unlimited, the time-lapse movie file will grow until your hard drive is full.  








MUSIC AND SOUND EFFECTS�tc "MUSIC AND SOUND EFFECTS" \l 1�





Music


Darwin Pond comes with three custom music compositions created by Jonah Sharp.  These are his artistic expressions inspired by the world of the swimmers.  You can choose between any of Jonah's pieces by going to the Options Menu, and choosing Preferences.  The Music section lets you choose which selections of music to choose from  The options are: 





1	"Round Trip"


2	"Hula"


3	"Overflow"


4	(no music)








Sound Effects


This brings up a dialog box for turning on or off different channels of the sound effects.  The three sounds to choose from are:  





1	Mating


2	Eating


3	Dying








THE DARWIN POND SCREENSAVER�tc "THE DARWIN POND SCREENSAVER" \l 1�





One of the obvious uses of Darwin Pond is as a screensaver.  We have developed a screensaver which not only lets you enjoy the motions of Darwin Pond's inhabitants in endless non-repeating variety, but lets you load up any of your Pond files as a starting state for the screensaver.  





Think of the screensaver as a version of Darwin Pond that you don't actually interact with.  It does all the things that the main application does except let you manipulate swimmers, food or the microscope.  





The Autotracker


Since swimmers are constantly moving around the pond, the screensaver needs to keep up with these mobile critters.  The Autotracker (see section on Microscope) is also used for the screensaver, to keep interesting activity on the screen at all times.  





Screensaver Settings


The following screensaver settings are available: 





Autotracking Magnification	


Sets the Microscope zoom level.  Range setting is from "Closest" to "Farthest. "  





Pond


You can choose to let the screensaver start with a standard Garden of Eden or with any Pond file that you have saved (NOTE: the screensaver cannot save an evolving Pond file for you - it can only start off with a pre-existing file).  





Pond Color


You can choose from either Greenish, Bluish, Brownish, or Black.  





Sound Effects


On or Off








SUGGESTIONS�tc "SUGGESTIONS" \l 1�





As you perform your experiments and explore the possibilities in Darwin Pond, you may come up with a few questions pertaining to breeding swimmers.  Here are a few pointers:





Let It Be


Want to breed a super race?  The Number One rule for getting a race of super swimmers is this: HANDS OFF!  Start a Garden of Eden running, go out for pizza, take your time.  Let Mother Nature do the hardest part of the job.  This is what she is good at.  Now, this doesn't mean you can't help outóyou just have to be smart about it.  A tweak here, a tweak there, most of it will take care of itself.  





Turning Swimmers into Couch Potatoes


You might be inclined to lavishly feed a nice-looking cluster of swimmers, thinking that if they are well-fed they might take it upon themselves to go out and get to work evolving.  Not so.  In fact, the more food a group of swimmers have at their disposal, the less motivated they are to venture out.  They become couch-potatoes, basically.  Remember, give them a little challenge.  





Not a Great Survivor, But a Hell of a Dancer


Of course, if your goal is to breed a swimmer that just looks really cool, that's another thing.  You have a number of options: You could use the "engineer swimmer tool" to "design" a swimmer.  Or you could start up a Garden of Eden, and intervene as the population evolves, cloning those swimmers that meet your aesthetic criteria, and killing off the ugly ones.  This may require lots of feeding on your behalf, since you are in fact breeding according to looks, not self-sufficiency.  The race of swimmers you breed will be more to your liking, but you'll find that it will probably need constant care in order to stay that way.  








KEYBOARD REFERENCE CHART�tc "KEYBOARD REFERENCE CHART" \l 1�








The following keystrokes are shortcuts to some of Darwin Pond's basic functions: 








Swimmer-related Functions


(control)-x (or shift-delete)	cut swimmer


(control)-c (or (control)-insert)	copy swimmer


(control)-v			paste swimmer


l  (lower case "L")		locate selected swimmer








Pond-related Functions


(control)-e	load up an Empty Pond


(control)-g	load up a Garden of Eden


(control)-o	Open a Pond File


(control)-s 	Save Pond File








Microscope-related Functions


i, +			zoom microscope in


o, -			zoom microscope out


arrow keys		move microscope view up/down/left/right


shift			reverse the zoom direction of the microscope tool while in use


r			reset microscope view


f			toggle on/off full screen mode
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